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Introduction to Mathcad 
Prepared by Gilberto E. Urroz, February 2006 

 
To get started, find the Mathcad 13 icon in your Start>Programs button in Windows.  
The Mathcad interface is shown below. 
 

 
 
The interface shows a main window and a Trace window.  At this point we will not use 
the trace window, therefore, you could click it off leaving only the main window for 
operations. 
 
Using Mathcad as a calculator 
Mathcad can be used as a calculator.  For example, click on the main window in an area 
near the top left corner, and type an equal sign (=).  This produces the following entry in 
the worksheet: 

 
The placeholder to the left of the equal sign (in red) is waiting for an entry.   Start typing: 
 

1+2/3+4/5 
 
Then, click somewhere else in the main window.   The result is the following: 
 

 
This exercise illustrates the use of Mathcad to perform simple calculations.   



2 

 
Functions in Mathcad 
Calculations may involve mathematical functions such as sin, cos, exp, etc.  You can 
insert any function by using the f(x) button in the toolbar .  Pressing this button 
provides a menu of functions.  The figure below illustrates the use of the function cosine: 
 

 
 
As an alternative, you can simply type the name of the function, i.e., cos.   
 
As an exercise, click in another area of the main Mathcad window, type an equal sign, 
and in the red placeholder type the following expression (you can either use the f(x) 
button or type the  name of the functions sin and cos): 
 
 

2.5*sin(2.5)+1.2*cos(2+3/(1+4*1.2^2)) 
 
 
Then, click somewhere else in the main window.  The result of this operation is now 
shown as: 
 

 
 

It is not always necessary to type the equal sign first to calculate a numerical expression.  
For example, click somewhere in the worksheet and type the following: 
 
 

(2.5+3.2/(1.2+sin(1.25)))= 
 
The result is: 
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Using Mathcad function root to find the root of an equation 
Explore on your own the functions available under the f(x) button.  Some functions, such 
as sin and cos, are straightforward mathematical functions, while others are Mathcad 
functions used to perform specific operations in the worksheet.  As an example, try the 
following exercise: 
 

1. Click in an area of the main Mathcad window 
2. Type an equal sign (=) 
3. Using the f(x) button, select function root under the Solving category.  Press the 

[Ok] button.  The result is the following:  
4. Click on the first placeholder and type x^3 [ ] –x-24 
5. Click on the second placeholder and type x 
6. Click on the third placeholder and type 0 
7. Click on the fourth placeholder and type 5 
8. Click somewhere else in the worksheet to see the result: 

 

 
 
Function root was used to find the solution of the equation x3-x-24 = 0, specifying that 
the unknown of interest is x, and providing the interval 0 < x < 5 as the preferred interval 
for the solution.  The right-hand side of this result shows that the root sought is x = 3. 
 
Defining variables in Mathcad 
To define a variable in Mathcad use the assignment operator, namely, a colon followed 
by an equal sign ,:=, which you can get by typing a colon ( ).  Click anywhere in the 
worksheet and make the following variable assignment:  x := -2.  Then, click somewhere 
else in the worksheet.  The value of 2 is now stored in the name x.  The value x = 2 will 
be replaced into any expression containing the name x that is located below or to the right 
of the assignment statement.  To check this fact, type an equal sign in a location above 
the assignment statement x:=2 and fill the placeholder to the left with the expression x2-3.  
The result is inconclusive, i.e.,  

 
 
 Then, repeat this operation in a location below or to the right of the assignment statement 
x:=2.  The result now is: 

 
 
Once you have made variable assignments, you can use the assigned variables to 
calculate expressions.  As an example, assign the values x: =-2 and y:=3, then calculate 
the following expression: x2+y2.  The result may look somewhat like this: 
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Documenting the worksheet 
In order to document your worksheet, you can add text to it by clicking on any place in 
the worksheet and typing ” followed by the text.  (Alternatively, you can use Insert>Text 
Region in the worksheet menu).  For example, the last exercise above, can be 
documented as follows: 
 

 
Selecting fields in the worksheet for editing and repositioning 
If you click on any of the text lines or the operations shown above, the corresponding 
field will be shown enclosed in a rectangle.  This indicates that the field can be edited for 
text or math calculations.  An example is shown below: 
 

 
 
A text or calculation field can also be selected by clicking in a region near the field and 
dragging the mouse towards the field.   In this case, the field is enclosed by a frame with 
a broken line for boundary, e.g.,  
 

 
 

When selected in this way, a field can be dragged and positioned somewhere else in the 
worksheet.  For example, the result shown above could be re-organized as follows: 
 

 
A field selected by dragging can be erased from the worksheet by pressing the [delete] or 
the [backspace] key.   The selected field can also be copied and pasted by using Cntl-C  
and Cntl-V, respectively.  By dragging on top of two or more fields, multiple fields can 
be selected for deletion, copying, or relocation. 
 
Equation solution using variables 
In an earlier section we introduced function root for the solution of equations.  The 
example presented earlier required four arguments, namely, the left-hand side of the 
equation, the unknown, and the limits of the interval where the solution was sought.  
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Using variables, we can provide an initial guess for the unknown, and then use function 
root with only the first two arguments to solve the equation.  The following example 
repeats the solution shown earlier, providing an initial guess through a variable 
assignment: 

 
 

Solution of a single equation using a Given-Find block 
Suppose that you want to solve and equation of the form f(…,x,…) = g(...,x,…) for x.   
The solution can be accomplished by using a Given-Find block according the following 
structure: 

                    x:= x0 
 
Given 
 
         f(…,x….) = g(…,x,….) 
 
         x:=Find(x)       x = 

 
where x:=x0 is an initial guess for the solution, and the symbol = in the equation is 
entered by pressing Cntl =.   Notice that the initial guess is shown before the Given-Find 
block, and that the solution requires the use of function Find after the equation is defined.  
To see the solution to the equation, we add the expression x =  to the right of the Find 
statement.  The field x= will show the actual value of the solution.   Consider the 
following example: 

 
To find a different real solution for the equation (if it exists) start with a different initial 
guess.  For this case, for example, we change the initial guess from -2 to, say, 5.  
Mathcad then recalculates the solution automatically.  The new result is shown below: 
 

 
 

Note: If you’re not sure that Mathcad has recalculated your solution, you can force a 
recalculation by pressing the Calculate button in the toolbar . 
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Solving multiple equations with a Given-Find block 
The solution of multiple equations requires defining all the equations after the Given 
particle in the block, and using a vector to which function Find is assigned.  Here is an 
example: 

 
Notes: 

1. Initial guesses for the unknowns (x:=2, y:=3) are required before the Given block. 
2. Remember to use Cntl = to generate the symbol = in the equations. 
3. To enter the vector to which function Find is assigned, use the Vector and Matrix 

toolbar button in the toolbar .   This generates the following palette: 
 

 
 

Press the Matrix and vector button , to generate the following entry form: 
 

 
 
To enter the vector required in the example above, select 2 rows and 1 column.  
Then type the variable names x and y in the corresponding placeholders.[As an 
alternative way to enter a vector or matrix, use Cntl+M after selecting an entry 
location in the worksheet]. 

 
4. Type x=  and y =  after function Find to see the results for x and y. 

 
The approach presented here for 2 equations can be generalized to any number of 
equations.  In the following example, we use a Given-Find block to solve a problem in 
hydraulics. 
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Notes:  
[1] - Use Format>Properties and select Highlight Region in the Display tab to highlight 
a region in the worksheet.  Press the [OK] button when done.   Highlighting could be use 
to emphasize solutions in a worksheet as shown above. 
[2] – This example illustrates the use of units in the calculations.  Units usage is 
discussed in a subsequent section. 
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Using Greek letters in expressions 
A palette with Greek letters is available by pressing the αβ  button in the toolbar .  
The resulting floating palette is shown below: 
 

 
 

Clicking on any of the letters will copy that letter to any entry point or text in the 
worksheet.  To illustrate this situation we perform a calculation with trigonometric 
functions that features the value π: 
 

 
 
Notice that Mathcad assigns the proper value to the symbol π in the calculation.  [Note: 
The arguments of trigonometric functions in Mathcad need to be in radians.  To convert 

an angle in degrees (θ o) to its equivalent in radians (θ r), use: or θπθ ⋅=
180

]. 

 
Besides π, there are other Greek letters that have special meanings: 
 

• δ : calculates Kronecker’s delta function, δ(i,j) = 1 if i=j, or δ(i,j) = 0 if i≠j.  δ can 
also be used to represent the impulse function δ(x). 

• ε : calculates the third-order epsilon tensor, e.g., .  This tensor is used 
in the definition of determinants for 3x3 matrices. 

• Γ : calculates the Gamma function, e.g., .  This function is related to 
factorials of integer numbers as follows:  Γ(n+1) = n!.  The Gamma function is 
also used to define probability distributions of continuous random variables. 

• Φ : calculates Heaviside step function, Φ(x) = 0 if x<0, Φ(x) = 1 if x>0. 
 
An alternative way to enter Greek letters is to type the equivalent English letter and then 
type Cntl G.  Try this exercise, after clicking on an entry location in the worksheet: 
 

a Cntl G := sin(60*p Cntl G/180) + cos(75*p Cntl G/180) 
 
Verify that the value of α is 1.125. (Click in a location below the equation above, and 
type  a Cntl G =  ). 
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Calculations using units 
Units can be attached to numerical values by using the units button in the toolbar .   
Pressing the button provides a menu of units as shown below (here, the SI unit of energy, 
the joule, is selected).    

 
 
Pressing the [OK] button at this point would attach the joule units to a numerical value.  
As an exercise, define, in your worksheet, the following variables with units, and 
calculate the expression shown for v: 
 

 
Notes:  

1. To attach units use the symbol * between the numerical value and the unit.  For 
example, type v0:=2.5*m/s, then click somewhere else in the worksheet. 

2. Although there is category for units of Velocity, the unit m/s is not included 
because it can be put together from m (in the Length category) and s (in the Time 
category).  As an alternative, you can simply type the unit combination: m/s. 

3. The calculation shown above uses five fields.  The three fields in the first row 
were used to define variables with units.  The first field in the second row 
represents the calculation of the variable v := v0+at.   However, this operation 
alone would not show the value of v.  For that we need to add the last field in the 
second row, i.e., type v = 

 
By default, a calculation involving units, Mathcad will provide the final result in units of 
the SI (Syteme International), e.g., 
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Another example: 

 
To change the default unit system, select Tools>Worksheet Options, and click on the Unit 
system tab (see below).    
 

 
 
The units systems available include MKS (meter-kilogram-second), CGS (centimeter-
gram-second), and US (i.e., U.S. customary, or English, system).    For example, 
selecting US as the default Unit system produces the following result for the last example 
above: 

 
After a result has been calculated, you can do a unit conversion by replacing the units in 
the result with an equivalent unit.  For example, the following calculations (with US as 
the default Unit system), provide a result in psi (pounds per square inch): 

 
If you click on the psi units, a placeholder appears to the right of psi.  Click on the 
placeholder and type psf (pounds per square foot) to convert the result to those units, i.e.,  
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It is possible to define your own units as in the following example, in which the unit cfs 
(cubic feet per second) is defined by the user.   The result, provided by Mathcad, is given 
in gpm (gallons per minute): 
 

 
 
By clicking on the gpm units and replacing the placeholder with cfs  we get: 
 

 
 
Saving the worksheet 
To save the worksheet, use File>Save As … and give it a name (e.g., FirstWorksheet).  
The file will be given the sub-index xmcd.   Older versions of Mathcad used mcd. 
 
To create a new worksheet, use Cntl-n.  Here is an example of a well-documented 
Mathcad worksheet: 
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Here is another example of a Mathcad worksheet showing the solution to a compressible 
flow problem: 
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Defining, tabulating, and plotting a function 
A function of a single variable can be defined by using, for example, f(x) = expression.  
An example is shown below.  After defining the function we evaluate it at x = 3.5, and 
use it to find its roots with Mathcad function root as shown.  After finding the roots, the 
function is evaluated at the roots to verify that f(x) = 0 at those points: 
 

 
 
To produce a table of the function we need to define a vector of values of the independent 
variable x in a certain range a < x < b.  Suppose that we want to divide the interval [a,b] 
into n sub-intervals of the same width Δx = (b-a)/n, then we can define the vector of 
values of x using the rule xj = a + j Δx, for j = 0, 2, …, n.  [Check that a = x1 and b = 
xn+1].  Subsequently we can produce a vector of values of yj = f(xj).   To show the table of 
y-vs-x values, create a matrix (e.g. Z) and define x as its first column, and y as its second 
column.  The type Z = . A table of values of the function defined above is shown next: 
 

 
 
Notes: 
 

1. To enter a range (e.g., j:= 0..n), use a semi-colon between the range limits.  For the 
example above, use:  j := 0;n 

2. To enter a sub-index,  type [ or click on the sub-index button in the toolbar . 
3. If you prefer to see the table in the form of columns, change the assignation to 

matrix Z to the following:   Zj,0 := xj     and    Zj,1 := yj. 
 
To produce a graph of the function, first, we need to generate the vectors of values of x 
and y, as we did above.  Then, click on the region of the worksheet where you want the 
graph, and press the Graph toolbar button in the toolbar  .   From the resulting menu, 
select the X-Y Plot button .    You will now have a graph frame with six placeholders, 
as shown in the following figure.    
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Replace the middle placeholders with x and y (or xj and yj) to produce one of the 
following graphs: 

 
 
The graphs above use a default range for x, namely, -5 < x < 5.  To change the range in a 
graph, click on the graph and replace the values shown at the ends of each axis.   For 
example, in the figure below we change the range to -2 < x < 5: 
 

 
 
The following example shows the development of a plot using polar coordinates.  The 
function to plot is r = g(θ) = 5 (1-cos(θ)).   The function is defined, and values of θ and r 
are generated as follows: 
 

 
 



15 

To produce a table of the r-θ data, use a matrix T for this case: 
 

 
 
To select a polar plot, use the polar plot button   after clicking on the Graph toolbar 
button  .   The resulting plot is shown below, after replacing the names θ and r in the 
appropriate placeholders: 

 
 
The resulting curve is known as a cardiod (i.e., heart-shaped). 
 
Tables and plots of multiple functions 
The approach shown above for tabulating and plotting a single function can be 
generalized to the tabulation and plotting of two or more functions.   Try the following 
exercise: 
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The plot of y-vs-x combined with that of z-vs-x is shown below.  To produce this plot 
enter x in the horizontal axis (the abscissas) placeholder, and type y,z in the vertical axis 
(the ordinates) placeholder.  The graph shown was enlarged by clicking on the graph and 
then dragging the lower right corner away from the center of the graph. 
 

 
 
To change the properties of the graph, click on the graph and then do a right-click with 
the mouse.  Select the entry Format from the resulting menu.  The current (default) 
settings for axes properties are shown below: 
 

 
 
Select the [ ] Grid lines in both axes (X-Axis and Primary Y Axis), and select Crossed for 
the Axis Style.  Press the [Apply] button to effect these changes in the graph.  Then press 
the [OK] button.  The modified graph is shown below: 
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Click on the graph once again, and do a right-click to select the Format window.  This 
time, however, select the Label tab, and modified it to read as follows: 
 

 
 
The fully-documented graph is shown below: 
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The following example illustrates the tabulations and plotting of two curves using a polar 
plot: 

 
 
The graph is shown below: 

 
 
Using the Format option from a right-click on the graph, select Gridlines for both the 
Radial and Angular coordinates, and Crossed for the Axis style in the Polar Axes tab.  
Also, in the Labels tab, type the following title: Antenna radiation.   To modify the plot 
press the [Apply] and [OK] buttons.  The resulting graph is shown below: 
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Multiply-defined functions 
Suppose that we want to define the function  
 

⎩
⎨
⎧

≥−
<−

=
1,1
1|,1|

)(
xforx
xforx

xf . 

 
Mathcad provides function if for this purpose.  The following exercise shows the 
definition of this function as well as a table and a plot of the same in the range -5<x<5: 
 

 
The if function has the general form if(condition, option true, option false).  If condition 
is true, then option true is selected.  If condition is false, then option false is selected. 
 
Consider now the following multiply-defined function that includes more than two 
possibilities: 
 

⎪
⎪
⎩

⎪⎪
⎨

⎧

≥−

<≤−

<−

=

5,1
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xf . 

 
In this case it is possible to use a nested if function by re-defining the function statement 
as follows: 
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Thus, using Mathcad’s if function you can write: 
 

if(x<0,x-1,if(x<5,x2-1,1-x2)) 
 
The following figure shows the implementation of this function in Mathcad, including a 
table and plot of the function: 

 
 
Symbolic evaluation of calculus operations 

Use the Calculus Toolbar button in the toolbar  to produce the calculus toolbar: 
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The Calculus Toolbar includes buttons for limits, first- and higher-order derivatives, 
definite and indefinite integrals, summations, and products, as well as the infinite symbol.  
To calculate a symbolic (as opposite to a numerical) result, instead of using the equal sign 
we use the symbolic evaluation symbol , generated by using Cntl . (control period) in 
an expression.  [Alternatively, the symbolic evaluation symbol ( ) can be selected from 
the Evaluation Toolbar (click the  button in  the toolbar)]: 
 

 
 
The symbolic evaluation symbol is the arrow located in the second row, first column of 
the Evaluation Toolbar shown above ( ). 
 

The following example illustrates the symbolic evaluation of the derivative )( 3 xx
dx
d

− .  

First, select the derivative button ( ) from the Calculus Toolbar.  Then, type x in the 
lower placeholder and (x3+ x) in the higher placeholder.   Finally, enter the symbolic 
evaluation symbol from the Evaluation Toolbar, or by typing Cntl ..  The result is shown 
below: 
 

 
 
Using the proper symbol from the Calculus Toolbar and the symbolic evaluation symbol 
( ) evaluate the following calculus operations: 
 

• A limit that defines a derivative 
 

 
 
• A third-order derivative 

 

 
 

• An infinite sum 
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• A symbolic product 
 

 
 

• An indefinite integral  
 

 
 

• A definite integral with an infinite limit 
 

 
 

• A definite integral with symbolic limits 
 

 
 

In the last expression we borrowed the square-root symbol ( ) from the Calculator 
Toolbar, which is activated by pressing the Calculator Toolbar button in the toolbar 

.  The Calculator Toolbar is shown below.   It includes symbols for trigonometric, 
logarithmic, and exponential functions, square root, any root, inverse, square, power, 
π, factorial, i (the unit imaginary number), improper fraction ( ), the 10 digits, 
parentheses, and the four fundamental arithmetic operations.  
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Numerical evaluation of summations, products, and integrals 
Summations, products, and integrals with numerical limits can be evaluated by Mathcad 
if we use the equal sign after the corresponding operation.  Some examples are shown 
next.  In each example we show both the numerical and the symbolic evaluation: 
 

 
 
In all the examples above the value of the operation converges to a finite result.  If the 
operation diverges, a numerical evaluation would be inconclusive and Mathcad will 
provide a no-convergence message.  The symbolic evaluation shows the result being 
infinite: 
 

 
 
Calculus operations on user-defined functions 
Users can define functions in Mathcad and subsequently use the operations in the 
Calculus Toolbar to calculate limits, derivatives, summations, products, and integrals.   
Other functions can also be defined based on those calculus operations of user-defined 
functions.   In the following example a user-defined function f(x) is used to define a 
second function fp(x) =df/dx, and tables and plots of the two functions are produced: 
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In the following example we attempt to repeat the last exercise for a multiply-defined 
function: 
 

 
 
Notice, however, that evaluating  fp(x) =df/dx in the range selected fails to converge.  
You can check that the problem occurs at fp(x9), i.e., at x9 = 5.   The problem is that the 
derivative of this function is doubly-defined at that point.  Thus, with the range of values 
of x as defined above we cannot produce a table or a plot of the function.  To avoid this 
problem we could re-define the range by adding, say 0.1, to a and b, i.e., 
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The table of values for both f(x) and fp(x), as well as a plot of the two functions, is shown 
below: 
 
 

 
 
 
Symbolic evaluation of derivatives in user-defined functions 
If the user-defined function uses a single expression, the symbolic evaluation is 
straightforward (recall that we use Cntl . [control period] to produce the symbolic 
evaluation symbol ): 
 

 
 
Symbolic evaluation of a multiply-defined function (using Mathcad function if) is not 
allowed, e.g.,  
 

 
 
 
One possibility is to apply the symbolic evaluation operator to each expression in the 
multiply defined function as illustrated below: 
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Thus, the derivative function could be defined as follows: 
 

 
 
Functions defined by summations and integrals 
Consider the function g(x) defined by a single expression.  The following exercise shows 
two other functions gs(x) and gi(x) defined in terms of a summation and an integral of 
function g(x).  This case is straightforward.  As shown below, the symbolic expressions 
for functions gs(x) and gi(x) can be easily calculated using the symbolic evaluation 
symbol : 

 

 
 

An attempt to define a function with the integral of a multiply-defined function fails: 
 
 

 
 
 

As we did in the case of the derivative of a multiply-defined function, we can define the 
symbolic integrals separately by range, i.e.,  
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Then, we can put together the integrated function, fs(x), as follows: 
 

 
 
A table and graph of the two functions, f(x) and fs(x), are presented below: 
 

 
 

 
The same result can be obtained by defining the integrated function fs(x) as follows: 
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Functions defined by a Given-Find block 
This approach is useful if you need to calculate an implicit value in an equation.  A 
typical case is the Coolebrook-White equation used to calculate the friction factor in a 
pipeline.  The equation is given by 
 

 
 

Where f is the friction factor, Re is the Reynolds number, e is the absolute roughness of 
the pipe, and D is the pipe’s diameter.  Due to the complex nature of the equation, it is 
not possible to solve for f explicitly.  A Given-Find block can be used to solve for f if the 
values of Re, e, and D are known, as illustrated below: 
 

 
 
It is possible to define a function ffact(e,D,Re) as follows [ffact stands for friction factor]: 
 
 

 
 
 
A couple of evaluations of the function are shown below: 
 

 
 

 
We can use function ffact to calculate the velocity of flow V in a pipe of length L, 
diameter D, absolute roughness e, if a fluid with kinematic viscosity ν produces a head 
loss hf.   The equation to use is the Darcy-Weisbach equation defined as 
 

g
V

D
Lfh f 2

2

⋅⋅= , 
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where f = ffact(e/D,Re), and Re = VD/ν.   To set up the equation for solution in Mathcad 
we can write the Darcy-Weisbach equation as: 

 

g
V

D
LDV

D
effacth f 2

,
2

⋅⋅⎟
⎠
⎞

⎜
⎝
⎛ ⋅

=
ν

. 

 
A solution for the velocity is shown next: 
 
 

 
 

 
The Darcy-Weisbach equation, written in terms of the discharge Q, is 
 

52
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Where Re = 4Q/(πνD), and Q = (πD2/4)V.  Solving the example given above in terms of 
the discharge produces the following Mathcad result: 
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Symbolic manipulation of algebraic expressions 
The menu Symbolics in Mathcad contains functions for manipulation of algebraic 
expressions, e.g., Simplify, Expand, Factor, and Collect.  To illustrate this point, type in 
your worksheet the expression: 

 
 

Then, click on the expression and drag the mouse through it highlighting the entire 
expression.  The expression should look like this: 
 

 
 
Select Symbolics>Simplify while the expression is highlighted.  The result is a new field 
in the worksheet with the simplified expression, i.e.,  
 

 
 
Using text (“), and dragging fields around the worksheet, you can document and 
manipulate the operation once it is performed to make it easier to follow, e.g., 
 

 
 
Here are examples of the functions Expand, and Factor after manipulation (the operation 
of these two functions is similar to that of Simplify, presented above): 
 

 
 
The commands Simplify, Expand, and Factor can be activated using the Symbolic 
Keyword Evaluation symbol , available in the Evaluation Toolbar .  This symbol 
can also be obtained by using Cntl Shift . (control shift period).  Activating the Symbolic 
Keyword Evaluation symbol produces the following field: 
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The first placeholder (to the left) is where the expression to be operated upon is written, 
while the second placeholder is for the user to type the operation to be performed (i.e., 
simplify, expand, or factor).  The preferred filling of the placeholders is from the right to 
the left, thus, first type the operation name, e.g., expand, and then type the expression to 
be expanded, e.g., (x-y)2.  
 
Repeating the exercises shown above with the Symbolic Keyword Evaluation symbol, we 
get the following results: 

 
The command collect can be used with the Symbolic Keyword Evaluation symbol, by 
typing collect followed by a comma and the factor used for collecting terms.  For 
example, in the following result we used collect,x2 to collect all terms with x2 in the 
expression shown: 
 

 
 
To produce a vector of polynomial coefficients, use the Symbolic Keyword Evaluation 
symbol, typing coeffs followed by a comma and the polynomial variable.  The following 
examples show the coefficients of four third-order polynomials: 
 

 
 
Notice that the vector of coefficients is filled vertically downwards from the lowest to the 
highest powers of the polynomial variable.    
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Roots of a polynomial 
The following application illustrates the use of the polynomial coefficients operation in 
the calculation of the roots of a polynomial.  First, the polynomial is defined as p(x).  
Then, the polynomial coefficients are stored in variable v by using the Symbolic Keyword 
Evaluation symbol  and coeffs.  Finally, function polyroots is used to calculate the 
roots of  p(x): 

 
Notice that two of the roots of the polynomial shown above are complex numbers, 
namely, -0.372+1.394i and -0.372-1.394i.   The polynomial has two real roots, 0.412 and 
2.333.   
 
Visualizing the roots of the polynomial 
To visualize the real roots, we can produce a plot of the polynomial.  In the following 
example, we produce a range for x, namely, x:=0,0.1…3 (i.e., x := 0, 0.1;3), and a range 
for j:=1,2,…,4 for the indices of r.   The plot is produced with the abscissa placeholder 
containing x and rj, and the ordinate placeholder containing f(x) and f(rj).   To highlight 
the roots, make sure that, after the plot is produced, the Format tabs are as shown below: 
 

    
 
The results are shown in the next page: 
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Symbolic solution to single equations 
In this section we present two methods for the symbolic solution of single equations.  The 
first method consists of using the Symbolic Keyword Evaluation symbol (control shift 
period) with the keyword solve.  As an exercise, try the solution of the polynomial 
x3+10x2+19x-30 = 0, as follows: 
 

1. Type Cntl Shift . (control shift period) 
2. In the second placeholder type solve, x 
3. In the first placeholder type the polynomial x3+10x2+19x-30 Cntl = 0 
4. Click outside of the expression 

 
The result is the following: 
 

 
 

This result indicates that the polynomial has the roots x = -5, x = 1, and x = -6. 
 
The second method of symbolic solution uses a Given-Find block as illustrated below: 
 

 
 
The arrow after the Find particle is produced by typing Cntl . (control period). 
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Symbolic solutions need not produce numbers as results.  As an example consider the 
equation asvv 22

0
2 += .  Suppose that we want to solve for the variable a.  In such case, 

we can use one of the following approaches: 
 
1 – Using solve: 

 
 
2 – Using a Given-Find block: 
 

 
 
Symbolic solution to systems of equations 
The two approaches shown above for symbolic solutions of single equations can be used 
for solving systems of equations, if the equations and unknowns are grouped as column 
vectors.  Consider the following system of equations whose solutions are numbers: 
 

 
To write this expression follow the steps shown in the first example of the previous 
section, except that you will need to type arrays before and after the solve particle.  To 
enter an array, type Cntl-M and select, for this case, 2 rows and 1 column.  Then replace 
the placeholders with equations or unknowns. 
 
 A solution of the same system of equations using a Given-Find block is shown next: 
 

 
 
The solutions shown above correspond to the pairs (x,y) = (3,2), (2,3), (-2,-3), (-3,-2). 
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Symbolic solutions of systems of equations need not be numbers, as illustrated in the 
following example.  The equations listed to the left are those for position and velocity in 
a uniformly-accelerated motion.  The expression below uses Cntl Shift . (control shift 
period) and solve to solve simultaneously for v0 and a: 
 

 

The solutions to the system are:      )(
3
2,

3
)(2

02
0

0 vtxx
t

a
t

xxvt
v −−−=

−+
= . 

 
An alternative solution is shown next using a Given-Find block: 

 
The following example shows the solution to a system of linear equations.  Since the 
solution is symbolic, the results are given as integers or fractions: 
 

   
 
Given-Find blocks can be used to produce symbolic ( ) as well as numeric results (=) 
for systems of linear equations.  The first example shows a symbolic result. 
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A numerical result requires a first guess for the unknowns: 
 
 

 
 
 
Working with complex numbers 
To enter the unit imaginary number while typing a complex number, use 1i instead of 
simply i, e.g., type the following complex numbers z1:=3-2*1i and z2:=5-3*1i.  The 
result is the following values: 

 
Some basic arithmetic operations using these complex numbers are shown below: 

 
Trigonometric, exponential, and logarithmic functions can be applied to complex 
numbers, e.g., 

 
The absolute value function (use |) provides the modulus of a complex number, whereas 
function arg provides the argument.  Functions Re and Im represent the real and 
imaginary parts of a complex number.  To calculate a complex conjugate, type the 
complex variable name (or complex number), and press “.  Some examples are shown 
below: 
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A complex number of modulus r and argument θ, can be written as z = reiθ.  This is 
referred to as the polar representation of the complex number, as opposite to the 
Cartesian representation, z = x+iy. The following example shows the definition of a 
complex number in polar representation and its equivalent Cartesian representation: 

 
 
Complex solutions to equations 
If an equation has a complex solution, it is possible to use a Given-Find block, with a 
complex initial guess, to find that solution.  This is illustrated with the following 
examples: 

 
 
Graphics of matrices (example using complex functions) 
A complex variable is the variable z = x+iy = reiθ.   A function of a complex variable F(z) 
is also a complex variable, and so it can be written as   
 

F(z) = φ(x,y) + iψ(x,y) = φ(r,θ) + iψ( r,θ) 
 
The following exercise shows how to plot the real and imaginary part of the complex 
function F(z) = z1/2, by creating a grid of values in x and y.  The values of x and y 
generated below are vectors, which are used to put together a matrix of values   
 

zi,j = xi + iyj.   
 
The values of the complex function are stored in Φi,j = F(zi,j ).  The values of φi,j and ψi,j 
are matrices containing the real and imaginary parts of Φi,j.   
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To visualize these values we can use either a surface plot , or a contour plot .  These 
plots are available from the Graph Toolbar which can be activated by pressing the Graph 
Toolbar button in the Mathcad toolbar .  These two graphs have a single placeholder.  
Type the name of the matrix to be plotted in that placeholder.  The figures below show 
the real part, φ, and the imaginary part, ψ,  of the complex function F(z) in the form of 
surface plots.   
 

 
 
The same data is plotted next using contour plots:  
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Visualization of potential flows using complex functions 
In the description of potential flow, a function such as F(z) is referred to as a complex 
potential (or complex velocity potential), φ(x,y) is the velocity potential, and –ψ(x,y).  The 
contours of φ(x,y) represents the equipotential lines of the flow, while the contours of 
represent the streamlines of the flow.  The combination of these two plots represents the 
flow net of this flow.   To produce a flow net, produce a contour plot and type φ,ψ  in the 
placeholder.  The first version of the plot would actually show a contour plot combined 
with a surface plot, e.g., 
 

 
 
To produce a double contour plot, click on the plot, do a right-click and select the 
Properties option.  In the resulting form, click on the Plot 2 tab, and select Contour Plot, 
then press the [OK] button.  The resulting graph is the flow net of the flow corresponding 
to the complex potential F(z) = z1/2. 
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Vector field plot for flow velocities from a complex function 
The function w = dF/dz is referred to as the complex velocity, and is such that w = -u+iv, 
where u and v are the velocity components of the flow.  The following commands use the 
Vector Field Plot button ( ), in the Graph Toolbar.  The grid for the vector field was 
generated in a similar fashion to that used in the previous exercise, but reducing the 
values of M and N to 10.  The complex velocity matrix is ωi,j, and it’s calculated using the 
negative complex conjugate of w(z).   The function used for this case was F(x):=z2. 
 

 
 
A combined plot consisting of the contour plot of f(x,y) superimposed to the velocity field 
is shown next.  Notice that the streamlines are tangential to the velocity vectors: 
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Additional matrix plots 
While the examples shown above were derived from complex functions, matrices can 
created by typing in values into an array.  To define matrices use the Vector and Matrix 
Toolbar activated with the Vector and Matrix Toolbar button in the toolbar .  Within 
this toolbar press the Matrix or Vector button .  Select a matrix with 6 rows and six 
columns assigned to a variable M and enter the values shown below (or other values, if 
you want).  Then, define a matrix N = 2M-3.  Use the surface plot and contour plot 
buttons in the Graph Toolbar to produce the plots shown below. 
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A matrix of velocity vectors can be defined by using V = M+N*1i.  A plot of the velocity 
vectors is produced by using the Vector Field Plot button in the Graph Toolbar: 
 

 
 
 
A second example of a vector field plot is presented next.  Velocity components u(x,y) 
and v(x,y) are given, and arrays of values of x and y are generated to populate a grid in the 
x-y plane.  Velocity vectors Ui,j and Vi,j are generated as  
 

Ui,j = u(xi,yj) and Vi,j = v(xi,yj). 
 
To plot the vectors it is necessary to create a complex matrix  
 

Wi,j = Ui,j + i Vi,j. 
 

Then, a Vector Field Plot is generated by typing W in the graph placeholder: 
 
 

 
 

 
 



43 

 
 
 
Entering data into a matrix 
Suppose that we are going to bring in into Mathcad data from a text file.  Say that the 
data is available as a matrix in the text file elevation.txt, which looks as follows: 
 

 
 
 
The easiest way to enter data is to use the Data Import Wizard (Insert>Data> Data 
Import Wizard).  The resulting input form is the following (after browsing for file 
c:\elevation.txt).  Press the [Next] button three times to go through a number of options 
for reading the file.  Then press the [Finish] button.   The result is shown below. 
 



44 

 
 

 
 
Type M into the placeholder to make an assignment to a matrix M.   

 
 

Once entered into memory, the data can be manipulated or plotted as needed.  Surface 
and contour plots of matrix M are shown below: 
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Operations with matrices 
The Vector and Matrix toolbar contains some functions that can be used to manipulate 
matrices.    
 

 
 

 
For example, for the matrix M, entered above from file elevation.txt, we can use function 
MT to calculate the transpose of the matrix, or function M<> to extract columns of the 
matrix: 
 
 

 
 
 
In the following exercise, we store the transpose matrix in variable MT and extract 
columns of matrix MT: 
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Determinants and inverse matrices are only applicable to square matrices.  In the 
following exercise we define a square matrix A and calculate its matrix inverse (X-1) and 
its determinant |X|: 
 

 
 
Addition, subtraction, and multiplication of matrices are illustrated in the following 
examples: 
 

 
 
For term-by-term operations, use the Vectorize function ( ), e.g., 
 

 
 
Matrices used in the solution of systems of linear equations 
Given the set of linear equations  

x – 2y + 4z = 22 
6x - 3y + 2z = 17 
-8x + 9y + z = 42 

 
it is possible to write the matrix equation Ax = b, where the matrix A and the column 
vector b are defined as follows using Mathcad: 
 

 
 
The solution of the matrix equation is calculated using x = A-1b.  Using Mathcad: 
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Thus, the solution is x = 3.636, y = 7, z = 8.091.   To verify the solution, try: 
 

. 
 
Eigenvalues and eigenvectors of a square matrix 
Functions eigenvals(A) and eigenvecs(A) are used to calculate the eigenvalues, λ, and 
eigenvectors, x, of a matrix A.   The eigenvalue problem is described by Ax=λx.   An 
example of eigenvalues and eigenvectors calculation is shown below.   The result from 
the eigenvecs function is a matrix with eigenvectors in its columns. 
 

 
 
These results indicate that the eigenvalues and eigenvectors of the matrix A shown above 
are: 

λ1 = -5.828, x1 = [0.5, 0.707,-0.5], 
λ2 = 5, x2 = [ 0.707,0,0.707], and 
λ3 = -0.172, x3 = [-0.5, 0.707,0.5]. 

 
The generalized eigenvector problem is defined by Ax=λBx, where A and B are square 
matrices of the same dimensions.  Mathcad provides functions genvals and genvecs to 
calculate the eigenvalues and eigenvectors, respectively, of the generalized problem.  
Consider the following example: 
 

 
 
These results indicate that the eigenvalues and eigenvectors for the generalized problem 
with matrices A and B as shown above are: 
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λ1 = -0.038, x1 = [-0.669,0.358,0.06], 
λ2 = 0.661, x2 = [0.358,0.257,1], and 

λ3 = -15.161, x3 = [0.06,1,0.18]. 
 
Operations with vectors 
Besides the addition, subtraction, and matrix multiplications, vector operations include 
the dot product ( ), and the cross product ( ) for three-dimensional vectors.   Some 
vector operations are illustrated below.  The absolute value operation produces the length 
of the vector.  (Make sure that you don’t use the Determinant (|x|) operation from the 
Matrix and Vector toolbar.)  The operation Σv represents the sum of elements of the 
vector. 
 

 
 
Operations with elements of matrices and vectors 
Use sub-indices to extract elements of matrices and vectors.  Sub-indices can be entered 
by using the sub-index button ( ) or by using [ after the variable name.   Some examples 
of operations on elements of matrices and vectors are shown below, using the matrices A 
and B, and the vectors u and v, described above: 
 

 
 
Recall that, by default, indices in Mathcad start at 0, rather than 1.  [Note: To change the 
origin of array indices to 1, type ORIGIN:=1 before using the array.] 
 
Data fitting using vectors (linfit) 
The following example shows the fitting of discharge (Q) and head (H) data to a 
quadratic equation of the form H = a + bQ + cQ2, given three data points as shown in the 
worksheet.  The values of Q and H are entered as column vectors.  Function F(Q) is a 
vector function showing the functions whose linear combination will produces the fitting 
function sought.  The data fitting is obtained by using function linfit.  This function 
requires the following arguments: the vector of values of the independent variable Q, the 
vector of values of the dependent variable H, and the vector of functions F(Q).  The 
coefficients that accompany each function in F(Q) are obtained by using  
 

S := linfit(Q,H,F) 
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The function to be used for calculations is obtained by using h(Q) := F(Q)⋅S.  A plot of 
the original data and the fitted data is also shown to verify the fitting. 
 

 
 

 
 
As a second example of application of linfit consider fitting x-y data to a power function 
of the form  

y = axb. 
 
Since linfit requires a linear combination of functions, we could take logarithms of the 
equation and write it as  
 

ln(y) = ln(a) + b ln(x). 
 
Thus, a linear fitting for this case would be the function Y  = A + b ln(x), with A = ln(a) 
and Y = ln(y).  The following Mathcad demonstrate the use of function linfit to recover a 
power function: 
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Curve interpolation with splines 
Mathcad provides functions cspline, pspline, and lspline to perform cubic, parabolic, or 
linear spline interpolation.  These functions require vectors of data x and y as arguments, 
and return a vector of coefficients for the splines.  In the following example, we use cubic 
splines, and calculate the spline coefficient vector vs := cspline(x,y). 
 
Function interp is used to interpolate data out of the fitted splines.  The call to interp is 
interp(vs,x,y,xref), which returns the interpolated value of y at x = xref.  The example 
below shows also how to use function interp to plot the fitted cubic splines: 
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The reader is invited to repeat this exercise using the parabolic (pspline) and linear 
(lspline) spline fittings.   The graph below shows all three spline fittings and the original 
data in the same set of axes: 
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Surface interpolation with splines 
Functions cspline, pspline, and lspline can be used to interpolate spline surfaces by using, 
for example, the call cspline(M,z), where M is an nx2 matrix describing the x-y grid, and z 
is an nxn matrix describing the surface values to be fitted.  Columns 1 and 2 of matrix M 
represent the values of x and y defining the grid upon which the values of z are defined, 
i.e., zi,j = f(xi,yj).  An example of spline surface interpolation is shown below: 
 

 
 
Simple linear data fitting 
Given vectors of data x and y of the same length, a plot of y-vs-x could suggest a linear 
relationship of the form y = mx+b.  In order to calculate the slope (m) and the intercept 
(b) for the linear data fitting, Mathcad provides functions slope and intercept, i.e.,  
 

m:=slope(x,y), b:=intercept(x,y) 
 

A function yp(x):=m*x+b can be defined to produce the data fitting. 
 
The following example shows the calculation and graph of a linear data fitting for force-
deformation data.  First, the data is entered and a plot of the data is produced to check for 
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a linear relationship. Subsequently, Mathcad functions slope and intercept are used to 
calculate the parameters of the linear fitting.  Finally, a plot of the original and fitted data 
is produced. 
 

 
 

 
As a second example of application of functions slope and intercept consider fitting x-y 
data to an exponential function of the form 
  

y = aebx. 
 
This equation can be linearized by taking  logarithms of both sides, i.e.,  
 

ln(y) = ln(a) + bx 
 
Thus, a linear fitting for this case would be the function Y  = A + bx, with A = ln(a) and Y 
= ln(y).  Thus, for this case,  
 

b: = slope(x,ln(y)) 
 

A : = intercept(x,ln(y)). 
 
 
An example of fitting an exponential distribution is shown next: 
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Solution of first-order ordinary differential equations 
A first-order ordinary differential equation (ODE) is an expression of the form 
 

y’(t) = f(t,y(t)), 
 
subject to the initial condition y(t0) = y0.  An ODE of this type can be solved with 
function Odesolve, within a Given block, as illustrated in the following example.  Notes: 
To enter the prime symbol in this case, use Cntl F7.  Also, use Cntl = for the Boolean 
equal sign: 
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The solution is available for evaluation, e.g., 
 

 
 
or, it can be plotted as shown next: 
 

 
 
Other functions for the solution of ODEs are rkfixed, rkadapt, and radau.  The first two 
are Runge-Kutta solutions, one with fixed steps and one with adaptive steps, and the last 
one is used for stiff ODE systems.   
 
Next, we illustrate the use of function rkfixed for numerical solution of a first-order ODE.  
Function rkfixed is called using  
 

S:=rkfixed(Y0,t0,tf,n,D) 
 
where Y0 is a vector of initial conditions, t0 and tf are the initial and ending values of the 
independent variable, n is the number of steps in the solution, and D(t,Y) is the derivative 
function given in terms of the independent variable t and a number of unknown 
derivatives Y.   The equation is set up as dY/dt = D(t,Y), subject to Y(t0) = Y0.  This 
description assumes that the solution Y is a vector of values y(t), y’(t), y”(t), etc.  This set 
up corresponds to the solution of an ODE of any order that has been transformed to a 
system of first-order ODEs.   This approach will be illustrated below.  Here, we show 
how to set up and solve the problem solved above with Odesolve, but now solved with 
rkfixed. 
 
The following results show the setting up of the solution, and the use of function rkfixed 
to produce the solution matrix S.  The values of t get stored into T = first column (0) of S, 
while the solution y is contained in the second column (1) of S. 
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A plot of the solution is shown next: 
 

 
The following table, generated using transposes of matrix S, shows the first solution 
steps.  The remaining of the solution can be seen by clicking on the table and scrolling to 
the right. 
 

 
 
 
Solving a second-order ODE with rkfixed 
A second-order ODE of the form y”(t) + a y’(t) + b y(t) = g(t), subject to the initial 
conditions y(t0) = y0 and y’(t0) = y0’, can be re-written in terms of a vector of unknowns 
U defined as follows:  Let u1(t) = y(t), and u2(t) = y’(t), then  
 

u1’(t) = y’(t) =  u2(t), 
 
u2’(t) = y”(t) = g(t) – a u2(t) – b u1(t). 

 
In vector-matrix form, this is written as 
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We can now define the following vectors and matrices: 
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With the ODE system to be solved now being 
 

U’(t) = AU(t) + G(t) = D(t,U(t)) 
 
Subject to                                    U(t0) = U0 = [y0, y0’]T. 
 
This system can be solved with rkfixed as S:=rkfixed(U0,t0,tf,n,D). 
 
Consider the following case in which a = 2, b = 1, t0 = 0, y0 = 0, y0’ = 1, and g(t) = 
sin(t).  The following results show the solution of the differential equation  
 

y”(t) + 2 y’(t) +  y(t) = sin(t), y(0) = 0, y’(0) = 1. 
 
The first column of S represents the independent variable t, while the second and third 
columns represent y(t) and y’(t), respectively.  The two dependent variables are shown in 
the graph. 
 

 

 
 
This approach to the solution of a second-order ODE can be generalized to the solution of 
ODEs of any order, as long as it is linear. 
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ODE solution: gradually-varied flow (GVF) solution in a trapezoidal channel 
The solution of gradually-varied flow (GVF) in open channels involves solving a first-
order ODE after calculating the normal and critical flow depths.   An example of GVF 
solution in a trapezoidal channel is described next.  The figure describing the cross-
section was created in Paint and added with the menu option Insert>Picture. 
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Mathcad reference tables and User’s Guide 
Mathcad provides a nice collection of reference tables by choosing the Help>Reference 
Tables.   The options available are shown below: 
 

 
 
Clicking the Fundamental Constants link, for example, produces the following list of 
constants: 

 
 
Explore the reference tables on your own to identify those that may be helpful to your 
current classes or applications.  Scrolling down the Reference Tables one finds the user’s 
guide link which provides detailed instructions on the use of Mathcad’s different 
features.   
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Using Mathcad’s Tutorials  
Tutorials are Mathcad worksheets that provide basic instructions on the use of Mathcad 
functions.  Select the Help>Tutorials to access the available worksheets: 
 

 
 

A good place to explore for new users would be the Getting Started Primers link.  This 
will open a menu of links including one entitled Mathcad Toolbars.  Clicking on this link 
provides a worksheet describing the different toolbars.  For example, scrolling down the 
worksheet provides the following description of the Math Toolbar (some of which 
buttons we have presented earlier):  
 

 
 
Explore more of the Getting Started Primers on your own.  The menu in this Tutorial  
worksheet includes some of the subjects addressed in this document, e.g., Defining 
Functions, etc. 



62 

 
Using Mathcad’s QuickSheets 
QuickSheets are reference Mathcad worksheets that contain solved problems on a given 
mathematical subject.  To access QuickSheets select the menu option Help>QuickSheets.  
This action will open a menu of QuickSheets as shown below: 
 

 
 
The QuickSheets menu list a number of subjects for the user to select.  For example, if 
you are looking for an example for calculating a double integral, you could click on the 
Calculus and DiffEQs link to access the following menu: 
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Select the Numerical Double Integrals link to see an example.  The example, whose set 
up is shown below, describes triangular-shaped plate described by R = {c(x)<y<d(x), 
a<x<b} with a surface mass density f(x,y).   
 

 
 

Scrolling down the QuickSheet, we find a plot of the integration region as well as the 
following calculations for the mass and center-of-mass coordinates for a triangular plate 
with are density f(x,y), i.e., 
 

 
 
Using the File>Save As… menu option you can copy the QuickSheet into a new Mathcad 
worksheet that you can then modify to address a specific solution.    


